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Arm Microcontroller Lab Manual

INTRODUCTION

Microcontroller or Microprocessor is an electronic device which accepts data from memory or
input devices, process it according to instruction and sends or store result either in output devices
or memory.

Microprocessor contains no RAM, no ROM, and 1/O ports on the chip itself only CPU or
processor is present. To make it functional all should be added.

ARM Cortex M3 Series:

ARM was founded in 1990 as Advanced RISC Machines Ltd., a joint venture of Apple
Computer, Acorn Computer Group, and VVLSI Technology. In 1991, ARM introduced the ARM6
processor family, and VLSI became the initial licensee. Subsequently, additional companies,
including Texas Instruments, NEC, Sharp and ST Microelectronics, licensed the ARM processor
designs

Nowadays ARM partners ship in excess of 2 billion ARM processors each year. Unlike many
semiconductor companies, ARM does not manufacture processors or sell the chips directly.
Instead it licenses the processor designs to business partners. This business model is commonly

called Intellectual
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2. EXECUTION STEPS

Stepl: Open the Keil software and select the New Microvision project from Project Menu as

shown below.

File Edit Vl:‘wFIash Debug Peripherals  Tools SVCS Window Help

DS da || Mew pVision Project... || @
S Hm e New Mutti-Project Workspace...
Open Project...
Project o
—————————— Close Project
=84 Target 1 =
=-£3 Seurce G Export 3
starty Manage »
main
)l Select Device for Target Target
] Remove File ‘main.c’
st 4K Options for File 'main.c. Alt=FT
o
He  Ceantarget
sy [#] Buildtarget FT
Y€ 55 Rebuild all target files
€ Batch Build..
% Translate F\Tutorials_And_Codes\Lpe2148\main.c Ctri=F7
{44 | stop build
[¥] 1 FaTutorials_And_Cades\Lpc2148\PWM _Tutorial.uvproj
2 DA\SharedFalderBoardCodes\Lpc 768\ ExplareLpc1 768_BreakOut\0%a-RIC_UART\0%a-RTC_UART.uvproj
3 Di\SharedFolder\BoardCodes\Lpc1768\Explorel pc1763_BreskOuti06a_UART Tx_Char\06a_UART_Tx_Char.uvproj
4 DA\SharedFalderBoardCodes\Lpc1765\ExplareLpcl 768_BreakOut\05a-Led_3bit_Display\05a-Led_4bit_Display.uvproj
5 D\sharedFolder\BoardCodes\Lpc1768\ExploreLpc1768_BreakOut\04a-Led_8bit_Display\04a-Led_8bit_Display.uvproj
6 Di\SharedFolder\BoardCodes\Lpci768\Explorelpc1768_BreakOut\01a-LedBlinking\01a-LedBlinking.uvproj
7 C\KeilARM\Examples\Measure\Measure, uvproj
( 8 CAKeilARM\RLRTX Exampl es\Traffic\Traffic.uvproj
e ’—@ 0 5 C:\Keil\ARM\Examples\Hello\Hello.uvpraj _|_|
10 C:\Keil\ARM\Boards\KeiNMCB2130\Blinky\Blinky.uvproj
Build Output L= ]
Program Size: Code=204 RO-data=292 RW-data=0 ZI-data=60% ~
FromELF: creating hex file...
" \Objects\PWM_Tutorial.axf" - 0 Exzor(s), 0 Warming(s).
- w
Create a new pVision project Simulation 1110 C53 CAP NUM| SCRL OVR RAW

Step2: Browse to your project folder and provide the project name and click on

Save.

PWM_Tutorial - pVision4 - a
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
DS da@| & 5@ | | om o 2| @ systeminit MR @eoccea
£ [ B S S| B9 Targer
Project L - | mainc [ =
=54 Target 1 01 #include <ipcll () ~ 4 [l « Tutorials_And_Codes » Lpc1768 » LedBlink ~ | & | | searchLedBiink o
£ Source Group 02
[# startup LP ||| 03 wvold delay ms(®  Gganize +  New folder @
= 04 1
05 unsigned i @ Name Date modified Type Size
. Foriie o 9 Libraries
= [ Documents Ne items match your search,
09 & Music
10
11 #define SBIT_( (=) Pictures
12 #define SBIT_H B videos
13
14 #define SBIT_H
= Homegrou
= 2 group
16 #define SBIT_IJ
17 #define SBIT_IJ % Computer
- ::E?nﬂ et i Local Disk (C:)
20 #define SBIT_I s Local Disk (D)
> a NewVolume (E) w
22 #define SBIT_H
23 #define SBIT_R File name: | M -]
24 #aefine SBIT_H )
% taerine ssIr H Save as type: | Project Files (*.uvprej) v‘
26
28 #define PWM 1
< > 23 #define PWM 2 =
£ - |
— = ~
FromELF: creating hex file...
".\Objects\BWM Tutorial.axf" - 0 Erroxr(s), O Warning(s).

Local Disk (D) >
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Step3: Once the project is saved a new pop up “Select Device for Target” opens, Select the
controller(NXP:LPC1768) and click on OK.

LedBlink - pVisiond - a8
File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help

DS H@| 4 B9 o =P Rm R =S e G B st Mae @le o o al[F] X
© 8 e | ] rergett iy
“Project 7 @

NXF ffounded by Philips)
Device:
Tookset

Data base

@ Generic
-6 Luminary Micro
& Nuveton

by
& OKI Semiconductor

E-® ROHM

-8 Samsung

@ Sham

-6 Socle Technology Corp.

@ STMicroslectronics

-8 Texas Instuments.

& Toshiba

=-8% Winbond

& Ziog

@e. | (3 [0,7|

Build Output

Simulation 110 C:53 CAP NUM SCRL OVR R/W

Local Disk (D2} ™ ~ [mr all () 10:24 PM

Step4: Select the controller(NXP:LPC1768) and click on OK.

© LedBlink - pVisiond - g
File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help

DSH@| % B9 c|e|nnnn IE 1| B systeminit Mae(@le oo aF ]

i@mxﬂ@r_ﬁa\%\mm Eﬁ\lﬁ%

Project LN~

NXP flounded by Phiips)
LPC1768
ARM

Desciiption

R 525 Cox 2 ierocanialer wih HPU CPU ok po T00VF:

1512B on-chip Flash ROM with enhanced Flash Memory

bnSystem Progemning [57)and i Aoplcsion nga'rlrl'vg(lAF)

64<B RAM, Nested Vactored Intsmupt

Eicht channe! General pupose it W

Ethemet 10/100 MAC with RMIl interface and dedicated DMA,

LPC1769 USB 2.0full-speed Device controller and Host/OTG cortraller with DMA,

ity (CAN 2.08 with two channels, Four UARTS, one with full Modem nierace.
Three [2C serial nterfaces, Three SPI/SSF serial interfaces, I25 interface.

LPC1774 (General purpose 10 pins. 124t ADC with & channels. 1041t DAC,

LPC1776 Four 32:bt Timers with capture//compare. Standard PWM Timer block.

LPC1777 Quadrature Encoder,

LPC1778

LPC1785

LPC1786 (Crystal oscillstor, 4MHz intemal AC oscilator, PLL
LPC1787 =

IDDDDDDDDDDDDDGN

_“ Cancel
Ee.|@s | 0,7

Build Output

Simulation
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Step5: As LPC1768 needs the startup code, click on Yes option to include the LPC17xx
Startup file.

LedBlink - pVision4 -
File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help

DEH@ b DR 90| e | RRER|EEE G B e Mae @lecoal@]a

g@ﬁl@@ﬁl%‘mgm By 3=

Project 1B

Copy NXP LPC17xx Startup Code to Project Folder and Add File to
Project ?

I

Ee.|@e| 1[0,

Build Output g
~
v
< >

Simulation L10C53 CAP NUM SCRL OVR RW

Local Disk () > « [mr fii atl 9 10:26PM

Step6: Create a new file to write the program.

File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

=Nz M| @ Systeminit vad“\@|006"\\'&‘

ree Group 1
L. [# startup_LPC17n0s

Elproject|€F Books {} Func... [l Temp...|

Create an empty document t Simulation CAP _NUM| SCRL OVR R/W.

Local Disk (D) > = [®e §i] .al () 10:26 PM
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Step7: Type the code or Copy paste the below code snippet.

File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help

x
D@ s 2@l 9 | [ 7P M| | @ systemine FEIIE 06\\'\\
FE) E
Project Save the active document 0w @ -
524 Target 1 #incTude <Tpcl7xx.h>
265 Source Group 1

void delay_ms(unsigned int ms)

startup_LPC170cs
uinsigned int 1,J;
for (i=0;i<ms; i++)
for (§=0; §<500000; j++):
i

/* start the main program */
void main()

systemInit();
LPC_PINCON->PINSEL4 = 0x000000;
LPC_GPTO2->FIODIR = OxFFFFFfff;

while(1)
{

LPC_GPIO2->FIOSET = OxFFFfffff;
delay_ms(1);

LPC_GPIO2->FIOCLR = Oxffffffff;
delay_ms(1);

ElProject| @ Books | {} Func...| Oy Temp...| |14

Build Output

//Clock and pLL configuration
//configure the PORT2 Pins for GPIO;
//configure the PORT2 pins as OUTPUT;

// make all the port pins as high

// make all the port pins as Tow

Simulation

L24 C:o7

CAP NUM SCRL OVR RW

Local Disk (D) ® ~ (% 1| all ()

10:38 PM

Step8: After typing the code save the file as main.c.
LedBlink - pVisiond -7

File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help

DS AP % R|9 e [ m B == e ] B sstemint Ma# @leos@

"3 Ill @ |::1| fﬂ Target 1
Project Lo =] [ Textt E -
=324 Target 1 #include <Tpcl7xx.h>

E £5 Source Group 1

startup_LPC1700s
uins 4l « Tutorials And_Codes + Lpc1768 + LedBlink v ¢ Search LedBlink P
for(
fol Organize = New folder R
i &) Music A Neme B Date modified Type Size
Picty y
[osTary E v‘a e || LedBlink.plg 3/25/2016 1026 PM  PLG File 0KB
deos
LedBlink 3/25/2016 10:23 PM  pVisiond Project OKB
R | LedBlink Target 1.dep 3/25/2016 10:26 PV DEP File KB
1 % Homegroup N
LPC] D{ startup_LPCTPoc 10/29/201012:20...  SFile KB
hil
" ot
s Local Disk (C:)
Local Disk (D:)
5 New Volume (E)
ca javaDevelopers (F)
1 H" desktop (pc)
¥ v
File name: mam‘d v
Save astype: | All Files (%) v
Eeroject @pooks | runc.[ Oy 1emp..] ||[4] (= Hide Folders Save Cancel
Build Output
Simulation

1:24 C:97

CAP NUM SCRL OVR R/W

Local Disk (D) » «

Tl i)

10:39 PM
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Step9: Add the recently saved file to the project.

(%) 3
File Edit View Project Flash Debug Peripherals Tools SVCS  Window  Help

DS E@| % ai|9 o JE 15| @ systeminit Ma# e oo @

i

e m‘ u| Target 1

LS -
arg include <1pcl7xx.h>
-5 Target 1 01 #include <1pcl7xx.h -
& o ] w
A% Options for Group “Source Group T'.. At-F7 [fomed int ms)
Open File Re3s
Open List File Ly
Open Map File 000:5++)
(4] Rebuild all target files
%] Build target 7
-
Translate File program */
{5 Stop build
//Cleck and PLL configuration
Add Group... INSELS = 0X000000; //C PORTZ Pins as GPIO;
| Add Files to Group 'Source Group 1'.. ODIR = OxEELLffEff; //Con PORTZ pins as OUTPUT;
Remove Group ‘Source Group 1" and its Files
dh Manage Components..
Show Include File Dependencies FIOSET = OxfEEfffff; // Make all the Port pins as high
= Vi
24
2
% LPC_GPIO2->FIOCLE = OxffFfffff; // Mske all the Port pins as low
27 delay ms(100);
28 ¥
23 ) i
roje ooks unc...| 0, Temp...
[Elproject €FBooks {3 0,1 4 3
Build Output L < |
it Project Group simulation 1:20 C:85 CAP NUM SCRL OVR RAW

Local Disk (D) >« |m

Step10: Add the main.c along with system_LPC17xx.c.

LedBlink - pVisiond - o
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
DEH@ 4 RB|2c|a|mrnn : | B spteminit Ma# @ecsa
@ [ E S L] 8 o PR
Project P8 T mane -] -
=4 Target 1 01 #include <1pcl7xx.h> j
[E1-55 Source Group 1 02 %
- [#] startup_LPC1 s 03 void delay_ms [unsigned
04 1 =
05 uinsigned int i,3; Lﬂnk‘"'I 1. LedBink j - ok B~
06 = .
e for (i=0sims:ist) Name Date modified Type Size
08 for (§=0; 3<500000; 341 |l main 3/25/201610:39PM  C File 1KB |
03 system_LPC17 3/8/2016 410 PM CFile 23KB |
10
1
12 /# start the msin progx
13 void main()
14 1
15 SystemInit();
16 LPC_PINCCN->PINSEL4
17 LPC_GPI02->FIODIR =
18
19 while(l)
20 {
2
22 LPC_GPIO2->FIOSE
23 delay ms(100);
24 File name:  |'main c" "system_LPC170cc" Add
. l |
26 LPC_GPIO2->FIOCLE Filesoftype: |C Sourcefile ) - Close
27 delay ms(100); ! &
28 }
29 ) v | -
Erroject @Books (3 Func.. Oy Temp.. ][4 3
Build Output Dl x |
Simulation 1:20 C:85 CAP| NUM SCRL OVR RAW

Local Disk (D) >« |m 10:43 PM
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Stepl1: Build the project and fix the compiler errors/warnings if any.

x
File Edit View Froject Flash Debug Peripherals Tools SVCS Window Help
DEH@| b n|9c| LY VU] systeminit Hae @le s al 3|
4 9 L | Y2 Tergers e
Project [7%1 Buila F7) | (] mainc [ h
EE=] Eulild bargetles 01 #include <lpcl7xx.n> ZI
£+ Source Group 1 02
- [] startup_LPC1Tics 03 void delay_ms (unsigned int ms)
main.c U o
system LPC1Tocc EZ uinsigned int 1,3;
o7 for (i=0;i<ms;i++)
08 for (3=0;3<500000:344)
0
10 )
1
12 /* start the main program */
13 void main()
i
15 SystemInit(); //Clock and PLL configuration
16 LPC_PINCON->PINSEL4 = 0x000000; //Configurs the
17 LPC_GPIO2->FIODIR = OXffffffff: //Configure the PORTZ pins as OUTFUT:
18
19 while(1)
20 {
21
2 LPC_GPIO2->FICSET = OxEEEEELE; // Make all the Port pins as high
P delay ms (100} :
24
%
% LPC_GPIO2->FIOCLR = OxEfffELff; // Make a1l the Port pins as low
Py delay ms(100}:
2 ]

S 23 -
Erroject §FEooks ) Func.. OyTemp..| |4 »
Build Output L]
Build target files Simulation 1:13 €38 CAP| NUM SCRL OVR RAW

Stepl2: Code is compiled with no errors. The .hex file is still not generated.

4 x
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
DSHd@|s2ma[9c|es|p " 1| B systemint Mae @leocsal 3
B B e G| 8] o ERIr )
Project L > | [ mainc ﬂ] -
=559 Target 1 03 void delay ms (unsigned int ms) zl
£)-£5 Source Group 1 04t
startup_LPC17cs 05 onsigned int 1,3;
main.c 08 . . .
system LPC17occ o7 for (i=0;i<ms;i++)
08 for (3=0;3<500000;3+4)
0a
oo
11
12 /* start the main program */
13 int main()
1t
18 SystemInit(); //Clock and PLL configuration
18 LEC_PINCON->PINSEL4 = 0x000000; //Configure the PORTZ Pins as GPIO:
17 LPC_GPIO2->FIODIR = OXxffffffff: //Configure the FORTZ pins as OUTFUT:
18
19 while(1)
20 1{
21
22 LPC_GPIO2->FIOSET = OXfEEfffff; #/ Make all the Fort pins as high
23 delay_ms (100 ;
2
25
28 LEC_GPIO2->FICCLR = Oxffffffff; // Make all the Port pins as low
27 delay ms(100):

Eproject| @ Books | {3 Func...| 0, Temp.

Build Output

JEllF |

compiling main.c...
compiling system LEC1TXx.C...
linking.

Simulation L:27 C:27 CAP NUM SCRL OVR R/W

Local Disk (D) * 10:52PM

Enable Hex File Generation

DEPT OF ECE, HMSIT, TUMKUR 8
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Step13: Click on Target Options to select the option for generating .hex file.

| X
File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help
DEHG| b Ra|9c| e rnnn = ] @ stenin Mae @leosa|T]x
@ EE 85| 1| o M| & =]
Project L x | ,,_.,ﬁ Target Options... ‘ -
=34 Target 1 03 void Configure target options | + ms} j
£ £3 Source Group 1 oMo
startup_LPCTTiocs 05 unsigned int 1,3
main.c 06 . .
system_LPCITac 07 for (i=0;i<ms;i++)
08 for (3=0;3<500000;j++) ;
03
m 3
1
12 /* start the main program */
13 int main()
14 1
15 SystemInit (); //Clock and PLL configuration
18 LPC_PINCON->PINSEL4 = 0x000000; //Configure the PORTZ Pins as GPIO;
17 LPC_GPIC2->FIODIR = OxLLffffff; //Configure the PORTZ pins as OUTPUT;
18
13 while(1)
20 {
21
22 LEC_GPIO2Z->FIOSET = Oxffffffff; // Make all the Port pins as high
b delay ms(100);
24
25
26 LPC_GPIC2->FIOCLR = Oxffffffff: // Make all the Port pins as low
27 delay ms (100} ;
% » [
% 3 _Ij
Elproject @ Books | £} Func.. DyTemp..| |[14 3
Build Qutput L x |
compiling main.c... ~
compiling system LPCI7xX.C...
linking...

simulation CAP NUM SCRL OVR RW

Local Disk (0x) * al W3 10:53PM

Stepl4: Set IROML start address as 0x0000.

LedBlink - pVisiond - g
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

AEE IR E LRSI - = U | B sstemn M @eol e
S EE 2| E] e Mg & B
Project L <] e ﬂ} -
(=4 Target 1 03 void deld j
££3 Source Group 1 01
startup_LPC1 7. i3 unsig
mam“S’ e 5 Dswceulpull Listing | User | C/Ce+ | Aem | Linker | Debug | Utes |
system_LPCT T 07 TOr il \xp founded by Philps) LPCT76B
08 for ~Code Generation
09 Mal (MHz): [120
0 3
11 Operating system: [None +| | I Uss Cross-Module Optimization
12 /+ start ™ Use MicroLIB I~ Big Endian
13 int main
"
15 Syst I™ Use Link-Time Code Generation
18 LEC
1 LEC Read/Orly Memory Areas Memory Are=:
18 defautt  off-chip Start Size Statup | | default off-chip Start Size Nolnit
18 while( i
20 ¢ r I Ram: r
2 r I RAM2 r
2 L
» a r I Rama: r
24 on-chip
% ¥ ¥ IRamy: (10000000  [8D0D r
% L
27 ds r ™ IRAM2: |BDOCO0D  (0B0OD r
3 + =
= ]
[l project €FBooks | {} Func.. Oy Temp..| |[]4
et oot | s temo-| OK | Coe | Defauts | Hep |
Build Output
compiling main.c... ~
compiling system LPCI7XX.C...
linking...
Progr: Size: Code=1100 RO-data=332 RW-data=4 ZI-data=612

Simulation L27 C27 CAP NUM SCRL OVR R/W
Local Disk (D) > all ) 10:57PM
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Stepl15: Enable the option to generate the .hex file

LedBlink - pVision4 - 0
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

DEd@ s aajrc|esrinn 1 Iz | @ systemint Ma# e os &

@ 18 E @ 3| §| e M| &R
Project L] T :1 -
=524 Target 1 03 wvoid del] zl
53 Source Group 1 Mot
- startup_LPC1 750 05 unsigy
arupLEkHiees = Device | Target Output | Liting | User | C/Co | Asm | Linker | Debug | Lities |
main.c
system_LPC1Tiuc or for (1
08 for Select Folder for Objects Mame of Exscutable: [LedBink
03
10 )
1 @ Creste Bxecutable: \LedBink
e/ start ¥ Debug Infomation I™ Create Baich Fik
13 int main
4t [ Lreate HEX Filef
15 Syst
18 LPC | ¥ Browse Information
:; LEC_¢ " Create Library: \LedBink LIB
19 while(
20 {
2
2 Ll
23 de
24
25
26 L
2 a |
28 }
23 )
&l Project @ Books | {1 Func.. Oytemp..| |[|4 ok | come Dt i
=== r| auts b
Lol S ee————————
compiling main.c... ~
compiling system LECL7xxX.C...
linking...
Program Size: Code=1100 RO-data=332 RW-data=4 ZI-data=612

Simulation L27 G27 CAP NUM SCRL OVR R/W
11:01 PM

File Edit View Projet Flash Debug Peripherals Tools SVCS  Window Help

DEHS| %2R 9c| e rrnk | @ systeminit Ma® @lecsdd

& & H @ | B e e
Project 18 e n} -
5459 Target 1 03 void delay ms(unsigned int ms) ZI
-5 Source Group 1 04 1
startup_LPC17xs 05 unsigned int i,3:
[#) main.c 06
ystem LPCITecc ir for (1=0;i<ms;i+4)
- s for (3=0;3<500000; 3+4) ;
03
10y
1
12 /* start the main program */
13 int main()
14 {
15 SystemInit(}; //Clock and PLL configuration
16 LEC_PINCON->PINSEL4 = 0x000000; //Configure the BORTZ Pins as GPIO:
17 LEC_GPI02->FIODIR = OXxffffffff: //Configure the PORTZ pins as OUTBUT;
18
19 while(l)
20 {
21
) LEC_GPIOZ->FIOSET = OXEEELEEEE; // Make 211 the Fort pins as high
b delay ms(100);
24
2
2% LPC_GPIO2->FICCLR = Oxffffffff; // Make all the Port pins as low
2 delay ms(100);
28 H

E——— 20} -
Eproject €@ 50oks | {}Func., OyTemp..| ][4 _'IJ
'Build Output g

Build target 'Target 1'
linking...
Program Size: Code=1100 RO-data=332 RW-data=4 ZI-data=612

FromELE: creating hex file...
"LedBlink.axf" - 0 Ezzoz(s), 0 Wazning(s).

Simulation L27 C27 CAP NUM SCRL OVR R/W
Local Disk (D) *
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Stepl7: Check the project folder for the generated .hex file.

LedBlink - pVision4 - o
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
DSH@| % a9 c|es|mrEn|==/EE B s dRe* Qe o al@] A
S E B @ R W Tergett OEN
Project L < | main.c B v
=133 Target 1 03 void delay_ms(unsigned int ms) j
5 £3 Source Group | Mo
rtup_LPC17i0c5 05 unsigned i
: 0%
in.c
i=0: Home Share View v o
system_LPC17oue E; f°§ (2 r?;; )
o or (3=07 [C)] = 4 |« Lpcl768 » LedBlink v & | | Search LedBlink o
10 a B -
i A Favorites Name Date modified Type Size
12 /* start the B Deskiop ] LedBlink.axf 3/25/201611:02 PM  AXF File
13 int main() 5
SR %) Recent places [ cedBiink. hex 3/25/2016 11:02PM__ HEX File
15 Systenlnd 2] LedBlink Type: HEX File M HTML Document
16 LBC PING Size: 3.99 KB
” Lec PINCQ) G Libraries [ teaginkinp | 2B E8 o erooig 1z PM NP File
T - [ Documents | LedBlink.map DM MAP File
19 while(1) o Music | LedBlink.plg M PLG File
- ¢ =] Pictures [ LedBlinkra M TRAFile
?2 LBC_GH H videos LedBlink M uVisiond Project
n delay | | LedBlink_Target 1.dep M DEP File
24 *% Homegroup [ main M CFile
% )
= — | main.crt M CRF File
27 delay || ™ Computer | maind M DFile .
28 ) i Local Disk (C) - D 5
| 29 ) ) — _ e
Elproject| @ pooks | {}Func...|(yTemp..| || [4] | 2litems 1 item selected 3.99 KB g _"_I
L |

Build Output
Build target 'Target 1'
linking...
Program Size: Code=1100 RO-data=332 RW-data=4 ZI-data=612
FromELF: creating hex file...
"LedBlink.axf" - 0 Error(s), 0 Warning(s).

Simulation L5 C69 CAP NUM SCRL OVR R/W

Local Disk (D) > « (W 3l .l ) 11:08PM

Now .hex file with project name will be generated.
Working with Flash Magic Software :-

Now open the flash magic software and follow the below steps.
1. Select the IC from Select Menu(LPC1768).
Select the COM Port. Check the device manger for detected Com port.
Select Baud rate from 9600
Select None Isp Option.
Oscillator Freq 12.000000(12Mhz).
Check the Erase blocks used by Hex file option
Browse and Select the hex file.
Check the Verify After Programming Option.

© 0o N o g Bk~ w DD

If DTR and RTS are used then go to Options->Advanced Options-> Hardware Config
and select the Use DTR and RTS Option.

10. Hit the Start Button to flash the hex file.

11. Once the hex file is flashed, Reset the board. Now the controller should run your

application code.
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®* Flash Magic - NON PRODUCTION USE ONLY G
File ISP Options Tools Help

BH QA3SVRERS> @ | 0 33 If DTR and RTS are used then the below options needs to be
; selected in Options->Advanced Options->Hardware Config
Etace block 0 (O0D0DOOWO0FFF] A

| Erase block 1 (0x001000-0:001FFF]

J
} ""wds"’”‘msmnwdﬁs”ﬂ ) @UmDTRuﬂRISbmﬂRSTmﬂISPpﬁ
frr——— = ase all Flash+Code Rd Prot
Irndam:beone[ISP] v 7/ €dse blocks used by Hex Fils [IKeep RTS assested wide COM Port open

T80 |me 72100 |me

[ Asset DTR and RTS while COM Poit open
(] Dizable DTR and RTS completely

Hes Fie: D:\Led_Binking hex
Modified: Saturday, Macch 5, 2016, 9:35:22 AM

Gom bock checksuens Finally Hit the Start Button to flash the

[ Execute
| Ackivate Flash Bank

CAN Bus Tming Calculators at:
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EXPERIMENTS

Experiment Nol: Display Hello word in UART

UART module

UART module and registers. LPC1768 has 4-UARTSs numbering 0-3, similarly the pins are also
named as RXD0-RXD3 and TXDO0-TXD3.As the LPC1768 pins are multiplexed for multiple
functionalities, first they have to be configured as UART pins.

Below table shows the multiplexed UARTS pins.

Port Pin
PINSEL_FUNC 0 PINSEL_FUNC 1 PINSEL_FUNC 2 PINSEL_FUNC 3
Pin  Number

P0.02 98 GPIO TXDO ADCO[7]

P0.03 99 GPIO RXDO ADCO[6]

P2 0 48 GPIO PWM1[1] TXD1

P2.1 49 GPIO PWM1[2] RXD1

P0.10 62 GPIO TXD2 SDA?2 MAT3[0]
P0.11 63 GPIO RXD2 SCL2 MAT3[1]
P0.0 82 GPIO CAN1_Rx TXD3 SDAL
P0.1 85 GPIO CAN1_Tx RXD3 scL1

UART Registers
The below table shows the registers associated with LPC1768 UART.

Register Description

RBR Contains the recently received Data

THR  Contains the data to be transmitted

FCR FIFO Control Register

LCR Controls the UART frame formatting(Number of Data Bits, Stop bits)
DLL Least Significant Byte of the UART baud rate generator value.

DLM  Most Significant Byte of the UART baud rate generator value.

Steps for Configuring UARTO
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Below are the steps for configuring the UARTO.

1.

7.

o g~ w N

Stepl
Step2
Step3
Step4
Step5
Step6
Step6

: Configure the GPIO pin for UARTO function using PINSEL register.

: Configure the FCR for enabling the FIXO and Reset both the Rx/Tx FIFO.

: Configure LCR for 8-data bits, 1 Stop bit, Disable Parity and Enable DLAB.
: Get the PCLK from PCLKSELX register 7-6 bits.

: Calculate the DLM,DLL values for required baudrate from PCLK.

: Update the DLM,DLL with the calculated values.

: Finally clear DLAB to disable the access to DLM,DLL.

After this the UART will be ready to Transmit/Receive Data at the specified baudrate.

Main Code:-

#include <lpcl7xx.h>

#include "stdutils.h"

#define SBIT_WordLenght 0x00u
#define SBIT_DLAB 0x07u
#define SBIT_FIFO 0x00u
#define SBIT_RxFIFO 0x01u
#define SBIT_TxFIFO 0x02u
#define SBIT_RDR 0x00u
#define SBIT_THRE 0x05u

/* Function to initialize the UARTO at specifief baud rate */

void uart_init(uint32_t baudrate)

{

uint32_t var_UartPclk_u32,var_Pclk_u32,var_RegValue u32;

LPC_PINCON->PINSELO &= ~0x000000FO;
LPC_PINCON->PINSELO |= 0x00000050; // Enable TxDO P0.2 and p0.3

LPC_UARTO->FCR = (1<<SBIT_FIFO) | (1<<SBIT_RXxFIFO) | (1<<SBIT_TxFIFO); //
Enable FIFO and reset Rx/Tx FIFO buffers
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LPC_UARTO->LCR = (0x03<<SBIT_WordLenght) | (1<<SBIT_DLAB); // 8bit data,
1Stop bit, No parity

/** Baud Rate Calculation :
PCLKSELX registers contains the PCLK info for all the clock dependent peripherals.
Bit6,Bit7 contains the Uart Clock(ie. UART_PCLK) information.
The UART_PCLK and the actual Peripheral Clock(PCLK) is calculated as below.
(Refer data sheet for more info)

UART PCLK PCLK
0x00 SystemFreq/4
0x01 SystemFreq
0x02  SystemFreq/2
0x03  SystemFreq/8

**/

var_UartPclk_u32 = (LPC_SC->PCLKSELO >> 6) & 0x03;

switch( var_UartPclk_u32)

{

case 0x00:
var_Pclk_u32 = SystemCoreClock/4;
break;

case Ox01:
var_Pclk_u32 = SystemCoreClock;
break;

case 0x02:
var_Pclk_u32 = SystemCoreClock/2;
break;

case 0x03:
var_Pclk_u32 = SystemCoreClock/8;
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break:

var_RegValue u32 = (var_Pclk_u32 /(16 * baudrate ));
LPC_UARTO->DLL = var_RegValue_u32 & OxFF;
LPC_UARTO->DLM = (var_RegValue_u32 >> 0x08) & OxFF;

util_BitClear(LPC_UARTO->LCR,(SBIT_DLAB)); // Clear DLAB after setting DLL,DLM

/* Function to transmit a char */
void uart_TxChar(char ch)
{

while(util_IsBitCleared(LPC_UARTO0->LSR,SBIT_THRE)); // Wait for Previous
transmission

LPC_UARTO0->THR=ch; /I Load the data to be transmitted
}
int main()
{

char a[]="\n\rHello World";

int i;

Systemlnit();

uart_init(9600); // Initialize the UARTO for 9600 baud rate

for(i=0;a[i];i++) //transmit a predefined string

uart_TxChar(a[i]);
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Experiment No 2:-Speed Control of the DC Motor

DC Motor Control using PWM of LPC1768

In most of the applications controlling the speed of DC motor is essential where the precision
and protection are the essence. Here we will use the PWM technique to control the speed of the
motor

LPC1768 has one PWM channel with six ports. PWM changes the average output voltage by fast
switching. By changing the on time, the output voltage can be 0 to 100%. There are two software
parameters that need a little explanation: cycle and offset. Cycle is the length of a PWM duty

cycle and offset is the on time of a duty cycle.

SELECTING THE PWM FUNCTION TO GPIO:

The block diagram below shows the PWM pins multiplexed with other GPIO pins. The PWM
pin can be enabled by configuring the corresponding PINSEL register to select PWM function.
When the PWM function is selected for that pin in the Pin Select register, other Digital signals

are disconnected from the PWM input pins.

PWM Channel Port Pin Pin Functions Associated PINSEL Register
PWM1.1 P2.0 0-GPIO, 1- PWML1.1, 2-TXD1, 3- 1,0 bits of PINSEL4

PWM1.2 P2.1 0-GPIO, PWML1.2, 2-RXD1, 3- 3,2 bits of PINSEL4

PWML1.3 P2.2 0-GPIO, PWML1.3, 2-CTS], 3- 5,4 bits of PINSEL4

PWML1.4 P2.3 0-GPIO, 1- PWM1.4, 2-DCD1, 3- 7,6 bits of PINSEL4

PWML1.5 P2.4 0-GPIO, 1- PWML1.5, 2-DSR1, 3- 9,8 bits of PINSEL4

PWML1.6 P2.5 0-GPIO, 1- PWML1.6, 2-DTR1, 3- 11,10 bits of PINSEL4

PWM REGISTERS:
The registers associated with LPC1768 PWM are
e IR-> Interrupt Register: The IR can be written to clear interrupts. The IR can be read to

identify which of eight possible interrupt sources are pending.
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e TCR-> Timer Control Register: The TCR is used to control the Timer Counter functions.
The Timer Counter can be disabled or reset through the TCR.

e PR- > Prescale Register: The TC is incremented every PR+1 cycles of PCLK.

e MCR-> Match Control Register: The MCR is used to control if an interrupt is generated
and if the TC is reset when a Match occurs.

e MRO - MR6-> Match Register: Each can be enabled in the MCR to reset the TC, stop both
the TC and PC, and/or generate an interrupt when it matches the TC.

e PCR->PWM Control Register: Enables PWM outputs and selects PWM channel types as
either single edge or double edge controlled.

e LCR-> Load Enable Register: Enables use of new PWM match values.

Note: for detailed description of each registers kindly refer PWM waveform section

If you need to control the speed of a DC motor you have a few options. Controlling the
speed by controlling either voltage or current is inefficient. Let’s understand a bit the speed
control of DC motor Using Pulse Width Modulation because controlling how long the
voltage is applied with a certain frequency gives you the best control over the motor’s
speed.

Conventional power supplies tend to generate lots of heat because are working as variable
resistors pumping current through external circuits. The pulse width modulation circuits are
digital circuits which produce pulsed current. Due to the fact that the pulsed width
modulation power supplies works in a state in between on and off, the heat generated is

very low compared to the conventional power supplies.
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The duty cycle of the circuit can be changed by pressing the switches SW22 and SW23. If we
increase the duty cycle(press SW22), the speed of the motor increases and if we decrease the

duty cycle(press SW23), the speed of the motor decreases.
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Main code:-

#include <lpcl7xx.h>

void delay_ms(unsigned int ms)// delay routine
{
unsigned int i,j;
for(i=0;i<ms;i++)
for(j=0;j<60000;j++);
}
#define SBIT_CNTEN 0 //counter enable
#define SBIT_PWMEN 2 //[pwm 2 block enable
#define SBIT_PWMMROR 1 //This bit is used to Reset PWMTC
#define SBIT_PWMENA3 11 //This bit is used to enable/disable the PWM
#define PWM_3 4 //P2_2 (0-1 Bits of PINSEL4)

int main(void)
{
int dutyCycle;
Systemlnit();
/* Cofigure pins(P2_2 ) for PWM mode. */
LPC_PINCON->PINSEL4 = (1<<PWM_3) ;

/* Enable Counters,PWM module */
LPC PWM1->TCR = (1<<SBIT_CNTEN) | (1<<SBIT_PWMEN);

LPC_PWM1->PR = 0x00; /* No Prescalar */

LPC_PWM1->MCR = (1<<SBIT_PWMMROR); /*Reset on PWMMRO, reset TC if it
matches MRO */

LPC_PWM1->MRO = 100; I* set PWM cycle(Ton+Toff)=100) */

/* Enable the PWM output pins for PWM_1-PWM _4(P2_0 - P2_3) */
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LPC_PWM1->PCR = (1<<SBIT_PWMENA3);
while(1)
{

{
LPC_PWM1->MR3 = dutyCycle; /* Increase the dutyCycle from 0-100 */

delay_ms(5);
if(1(LPC_GPIO2->FIOPIN & 0x00000800))//if sw 23 pressed
{

while(!(LPC_GP102->FIOPIN & 0x00000800)):

dutyCycle-=10;  //decrement duty cycle 10%

if(dutyCycle<0)
{
dutyCycle=0;
}
}

else if(!(LPC_GPIO2->FIOPIN & 0x00001000)) //if SW 22 pressed

{
while(!(LPC_GP102->FIOPIN & 0x00001000));

dutyCycle+=10; //increment duty cycle 10%
if(dutyCycle>100)
{
dutyCycle=99;
}
}
}
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Experiment No 3:-Stepper Motor Interface and rotate clockwise and

anticlockwise

Stepper motor
A stepper motor or step motor or stepping motor is a brushless DC electric motor that divides a

full rotation into a number of equal steps. The motor's position can then be commanded to move

and hold at one of these steps without any position sensor for feedback (an open-loop controller),

as long as the motor is carefully sized to the application in respect to torque and speed.

How Stepper Motors Work

Stepper motors consist of a permanent magnetic rotating shaft, called the rotor, and
electromagnets on the stationary portion that surrounds the motor, called the stator. Figure 1
illustrates one complete rotation of a stepper motor. At position 1, we can see that the rotor is
beginning at the upper electromagnet, which is currently active (has voltage applied to it). To
move the rotor clockwise (CW), the upper electromagnet is deactivated and the right
electromagnet is activated, causing the rotor to move 90 degrees CW, aligning itself with the
active magnet. This process is repeated in the same manner at the south and west electromagnets

until we once again reach the starting position.
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e Figurel

e Inthe above example, we used a motor with a resolution of 90 degrees or demonstration
purposes. In reality, this would not be a very practical motor for most applications. The
average stepper motor's resolution -- the amount of degrees rotated per pulse -- is much
higher than this. For example, a motor with a resolution of 1.8 degrees would move its
rotor 1.8 degrees per step, thereby requiring 200 pulses (steps) to complete a full 360

degree rotation.

Here we are using 200 pole stepper motor hence it gives 360degree/200 pole=1.8 degree per

step.

So for example if we need 120 degree rotation then we have to apply approximately 67 pulses to
complete 120 degree rotation
120/1.8=66.66==67 steps approximately.

Here one cycle means 4 steps. So if we need 90 degree rotation then 90/1.8=50 steps.
Here one cycle means 4 steps. So 50/4=12.5 =~ 13. So we need 13 cycles to rotate 90 degree.
If we want to run 180 degree then 180/1.8=100. So 100/4=25 cycles would make a stepper

motor to rotate 180 degree.

Main code:- Step Angle Rotation
#include <lpcl7xx.h>

void delay(unsigned int ms)

{

unsigned int i,j;

for(i=0;i<ms;i++)
for(j=0;j<20000;j++); //delay subroutine
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[* start the main program */
int main()
{
int cycle;
Systemlnit(); /[Clock and PLL configuration

LPC_GPIO0->FIODIR |= 0x00078000; //Configure the PORTO pins as OUTPUT;

for(cycle=0; cycle<13; cycle++)// for loop condition for number of rotation. It gives
approx 90 degree rotation
{
LPC_GPIO0->FIOPIN = 0x00008000 ; // p0.15 pin
delay(100);
LPC_GPIO0->FIOPIN = 0x00010000 ;// p0.16 pin
delay(100);
LPC_GPIO0->FIOPIN = 0x00020000 ; //  p0.17 pin
delay(100);
LPC_GPIO0->FIOPIN = 0x00040000 ;// p0.18 pin
delay(100);

¥

Stepper motor rotation clockwise and anticlockwise.
#include "lpcl7xx.h"
void delay();

void delay()
{
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int i,j;
for(i=0;i<0xff;i++)
for(j=0;j<0x400;j++);

int main (void)

{

char rotate=0;
Systemlnit();

LPC_GPIO0->FIODIR |= 0x00078000;

while(1)
{
if(rotate==1)
{
LPC_GPIO0->FIOPIN = 0x00008000 ;
delay();
LPC_GPIO0->FIOPIN = 0x00010000 ;
delay();
LPC_GPIO0->FIOPIN = 0x00020000 ;
delay();
LPC_GPIO0->FIOPIN = 0x00040000 ;
delay();
}
else
{
LPC_GPIO0->FIOPIN = 0x00040000 ;
delay();
LPC_GPIO0->FIOPIN = 0x00020000 ;
delay();

LPC_GPIO0->FIOPIN = 0x00010000 ;
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delay();
LPC_GPIO0->FIOPIN = 0x00008000 ;

delay();

if(1(LPC_GP102->FIOPIN & 0x00000800))

{
while(!(LPC_GP102->FIOPIN & 0x00000800)):

rotate=1;

}
else if(!(LPC_GPIO2->FIOPIN & 0x00001000))

{
while(!(LPC_GP102->FIOPIN & 0x00001000)):

rotate=0;

ki
ki
ki
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Experiment No 4:-Display digital output for given analog input using internal

ADC

LPC1768 ADC Block

LPC1768 has an inbuilt 12 bit Successive Approximation ADC which is multiplexed among 8
input pins.

The ADC reference voltage is measured across VREFN to VREFP, meaning it can do the
conversion within this range. Usually the VREFP is connected to VDD and VREFN is connected
to GND.

As LPC1768 works on 3.3 volts, this will be the ADC reference voltage.

Now the $$resolution of ADC = 3.3/(27{12}) = 3.3/4096 =0.000805 = 0.8mV$$

The below block diagram shows the ADC input pins multiplexed with other GPIO pins.

The ADC pin can be enabled by configuring the corresponding PINSEL register to select ADC
function.

When the ADC function is selected for that pin in the Pin Select register, other Digital signals are

disconnected from the ADC input pins.

Adc Port ] ) Associated PINSEL
) Pin Functions )
Channel Pin Register
0-GPIO, 1-ADO0I[0], 2-12SRX_CLK, 3- _
ADO P0.23 14,15 bits of PINSEL1
CAP3[0]
0-GPIO, 1-ADO[1], 2-12SRX_WS, 3- _
AD1 P0.24 16,17 bits of PINSEL1
CAP3[1]
0-GPIO, 1-ADO0[2], 2-12SRX_SDA, 3- _
AD2 P0.25 18,19 bits of PINSEL1
TXD3
AD3 P0.26  0-GPIO, 1-ADO[3], 2-AOUT, 3-RXD3 20,21 bits of PINSEL1
AD4 P1.30 0-GPIO, 1-VBUS, 2-, 3-ADO0[4] 28,29 bits of PINSEL3
AD5 P1.31 0-GPIO, 1-SCK1, 2-, 3-ADO0[5] 30,31 bits of PINSEL3
AD6 PO.3 0-GPIO, 1-RXD0, 2-ADO[6], 3- 6,7 bits of PINSELO
AD7 P0.2 0-GPIO, 1-TXDO0, 2-ADO0[7], 3- 4.5 bits of PINSELO
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ADC Registers

The below table shows the registers associated with LPC1768 ADC.

We are going to focus only on ADCR and ADGDR as these are sufficient for simple A/D
conversion.

However once you are familiar with LPC1768 ADC, you can explore the other features and the

associated registers.
Register Description
ADCR A/D COntrol Register: Used for Configuring the ADC

ADGDR A/D Global Data Register: This register contains the ADC’s DONE bit and the
result of the most recent A/D conversion

ADINTEN A/D Interrupt Enable Register

ADDRO - A/D Channel Data Register: Contains the recent ADC value for respective
ADDR7 channel

A/D Status Register: Contains DONE & OVERRUN flag for all the ADC
ADSTAT

channels
Steps for Configuring ADC

Below are the steps for configuring the LPC1768 ADC.

1. Configure the GPIO pin for ADC function using PINSEL register.

2. Enable the CLock to ADC module.

3. Deselect all the channels and Power on the internal ADC module by setting ADCR.PDN
bit.

4. Select the Particular channel for A/D conversion by setting the corresponding bits in
ADCR.SEL

5. Set the ADCR.START bit for starting the A/D conversion for selected channel.

6. Wait for the conversion to complete, ADGR.DONE bit will be set once conversion is
over.

7. Read the 12-bit A/D value from ADGR.RESULT.

8. Use it for further processing or just display on LCD.
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Main ADC code

#include "lpcl7xx.h"
#include "lcd.h"
#define VREF 3.3 //Reference Voltage at VREFP pin, given VREFN = 0V(GND)
#define ADC_CLK_EN (1<<12)
#define SEL_ADO_2 (1<<2) //Select Channel ADO.2
#define CLKDIV 1 //ADC clock-divider (ADC_CLOCK=PCLK/CLKDIV+1) = 12.5Mhz @
25Mhz PCLK
#define PWRUP  (1<<21) //setting it to O will power it down
#define START_CNV (1<<24) //001 for starting the conversion immediately
#define ADC_DONE (1U<<31) //define it as unsigned value or compiler will throw #61-D
warning
#define ADCR_SETUP_SCM ((CLKDIV<<8) | PWRUP)
T Init ADCO CH2 /T
Init_ADC()
{
// Convert Port pin 0.25 to function as ADO.2
LPC_SC->PCONP |= ADC_CLK_EN; //Enable ADC clock
LPC_ADC->ADCR = ADCR_SETUP_SCM | SEL_ADO _2;
LPC_PINCON->PINSEL1 |= (1<<18) ; //select ADO.2 for P0.25
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T READ ADCO CH:2 /i
unsigned int Read_ADC()
{
unsigned int i=0;
LPC_ADC->ADCR |= START_CNV; //Start new Conversion
while((LPC_ADC->ADDR2 & ADC_DONE) == 0); //Wait untill conversion is
finished
i = (LPC_ADC->ADDR2>>4) & OxFFF; //12 bit Mask to extract result

k
I DISPLAY ADC VALUE /T

Display_ADC()

{

unsigned int adc_value = 0;

char buf[4] = {5},

float voltage = 0.0;
adc_value = Read_ADC();
sprintf((char *)buf, "%3d", adc_value); /I display 3 decima place
Icd_putstring16(0,"ADC VAL =000 ™); //1st line display
Icd_putstring16(1,"Voltage 00 V"); //2nd line display
lcd_gotoxy(0,10);
Icd_putstring(buf);
voltage = (adc_value * 3.3) / 4095 ;
Icd_gotoxy(1,8);
sprintf(buf, "%3.2f", voltage);
lcd_putstring(buf);

}

e AN

int main (void)

{

init_lcd();
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Init_ADC();

Icd_putstring16(0,"** HMSIT **");
Icd_putstring16(1,"** TUMKUR **");
delay(60000);

delay(60000);

delay(60000);
lcd_putstring16(0,"ADC Value.. ");
led_putstring16(1,"voltage.......");

while(1)

{

Display_ADC();
delay(100000);
}
}

1 0x01 Clear Display Screen

2 0x30 Function Set: 8-bit, 1 Line, 5x7 Dots
%) 0x38 Function Set: 8-bit, 2 Line, 5x7 Dots
4 0x20 Function Set: 4-bit, 1 Line, 5x7 Dots
5 0x28 Function Set: 4-bit, 2 Line, 5x7 Dots
6 0x06 Entry Mode

7 0x08 Display off, Cursor off

8 Ox0E Display on, Cursor on

9 0x0C Display on, Cursor off

10 OxOF Display on, Cursor blinking

11 0x18 Shift entire display left

12 0x1C Shift entire display right

13 0x10 Move cursor left by one character
14 0x14 Move cursor right by one character
15 0x80 Force cursor to beginning of 1st row
16 0xCO0 Force cursor to beginning of 2nd row
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LCD Code:-

#include "lpcl7xx.h"

#include "lcd.h"

void Lcd_CmdWrite(unsigned char cmd);

void Lcd_DataWrite(unsigned char dat);

#define LCDRS 9

#define LCDRW 10

#define LCDEN 11

#define LCD_D4 19

#define LCD_D5 20

#define LCD_D6 21

#define LCD_D7 22

#define LcdData LPC_GPIO0->FIOPIN

#define LcdControl LPC_GPIO0->FIOPIN

#define LcdDataDirn  LPC_GPIO0->FIODIR

#define LcdCtrIDirn  LPC_GPIO0->FIODIR

#define LCD_ctrIMask ((1<<LCDRS)|(1<<LCDRW)|(1<<LCDEN))

#define LCD_dataMask ((1<<LCD_D4)|(1<<LCD_D5)|(1<<LCD_D6)|(1<<LCD_D7))

void delay(unsigned int count)

{

int j=0, i=0;

for (j=0;j<count;j++)

for (i=0;i<50;i++);

}

void sendNibble(char nibble)

{
LcdData&=~(LCD_dataMask); /I Clear previous data
LcdDatal|= (((nibble >>0x00) & 0x01) << LCD_D4);
LcdDatal= (((nibble >>0x01) & 0x01) << LCD_D5);
LcdDatal|= (((nibble >>0x02) & 0x01) << LCD_D#6);
LcdDatal= (((nibble >>0x03) & 0x01) << LCD_D7);
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ky

void Lcd_CmdWrite(unsigned char cmd)

{

sendNibble((cmd >> 0x04) & 0xO0F); //Send higher nibble

LcdControl &= ~(1<<LCDRYS); // Send LOW pulse on RS pin for selecting Command register
LcdControl &= ~(1<<LCDRW); // Send LOW pulse on RW pin for Write operation
LcdControl |= (1<<LCDEN); // Generate a High-to-low pulse on EN pin

delay(100);

LcdControl &= ~(1<<LCDEN);

delay(10000);

sendNibble(cmd & Ox0F); //Send Lower nibble

LcdControl &= ~(1<<LCDRS); // Send LOW pulse on RS pin for selecting Command register
LcdControl &= ~(1<<LCDRW); // Send LOW pulse on RW pin for Write operation
LcdControl |= (1<<LCDEN); // Generate a High-to-low pulse on EN pin

delay(100);

LcdControl &= ~(1<<LCDEN);

delay(1000);

void Lcd_DataWrite(unsigned char dat)

{

sendNibble((dat >> 0x04) & 0x0F); //Send higher nibble

LcdControl |= (1<<LCDRS); // Send HIGH pulse on RS pin for selecting data register
LcdControl &= ~(1<<LCDRW); // Send LOW pulse on RW pin for Write operation
LcdControl |= (1<<LCDEN); // Generate a High-to-low pulse on EN pin

delay(100);

LcdControl &= ~(1<<LCDEN);

delay(1000);

sendNibble(dat & 0x0F); //Send Lower nibble
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LcdControl |= (1<<LCDRYS); // Send HIGH pulse on RS pin for selecting data register
LcdControl &= ~(1<<LCDRW); // Send LOW pulse on RW pin for Write operation
LcdControl |= (1<<LCDEN); // Generate a High-to-low pulse on EN pin
delay(100);
LcdControl &= ~(1<<LCDEN);
delay(1000);

}

void lcd_clear( void)

{
Lcd_CmdWrite( Ox01);

¥

int lcd_gotoxy( unsigned char x, unsigned char y)

{
unsigned char retval = TRUE;

ifl(x>1) && (y>15))

{
retval = FALSE;

¥

else

{
if(x==0) Lcd_CmdWrite( 0x80 +y); //Move the cursor to beginning of the first line

else if( x==1) Lcd_CmdWrite( 0xCO + y );// Move the cursor to beginning of the second
line
}

return retval;

}

void lcd_putchar( unsigned char ¢)

{
Lcd_DataWrite( ¢ );

¥
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void lcd_putstring( char *string )
{
while(*string '="\0")
{
Icd_putchar( *string );
string++;
}
}

void lcd_putstring16( unsigned char line, char *string )

{

unsigned char len = 16;

Icd_gotoxy( line, 0);
while(*string '="\0' && len--)
{
Icd_putchar( *string );
string++;
}
}
void init_lcd( void )
{
LcdDataDirn |= LCD_dataMask; // Configure all the LCD pins as output
LcdCtrIDirn |= LCD_ctrIMask;
Lcd_CmdWrite(0x03);//
delay(2000);
Lcd_CmdWrite(0x03);//
delay(1000);
Lcd_CmdWrite(0x03);//
delay(100);
Lcd_CmdWrite(0x2);// Initialize LCD in 4-bit mode
Lcd CmdWrite(0x28);// enable 5x7 mode for chars
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Lcd_CmdWrite(0x0e);// Display OFF, Cursor ON
Lcd_CmdWrite(0x06);//Entry mode
Lcd_CmdWrite(0x01);// Clear Display
delay(1);

}
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Experiment No 5:-Interface DAC and generate Triangular and Square

Waveform

LPC1768 DAC Programming Tutorial

In this article, we will go through a discussion on ARM Cortex-M3 LPC1768 DAC
programming tutorial. As you might be knowing, DAC stands for Digital to Analog Conversion.
The DAC block in ARM Cortex-M3 LPC176x microcontroller is one of the simplest to program
and also supports DMA(direct memory access). This tutorial is also applicable for LPC1769
MCU. Basically we assign a digital value to a register and the DAC block outputs it equivalent

analog signal as shown below:

VRerp
VREFN Y l
bg ——>
D) —
1 Agur
b —> DAC
b, ——>

LPC1768/LPC1769 DAC Block

ARM Cortex-M3 LPC176x MCUs incorporate a 10 bit DAC and provide buffered analog output.
As per the datasheet, it is implemented as a string DAC which is the most simplest form of DAC
consisting of 2N resistors in series where N = no. of bits which simply forms a Kelvin-Varley
Divider. LPC176x DAC has only 1 output pin, referred to as AOUT. The Analog voltage at the

output of this pin is given as:
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VALUE * (Vrerp-VRern)
1024

Vaour = + VRErn

When we have Vggry = 0. the equation boils down to:

VALUE * Vgegp
1024

Vaour =

Where VALUE is the 10-bit digital value which is to be converted into its Analog counterpart
and Vrer IS the input reference voltage.
Pins relating to LPC1768 DAC block:

Pin Description
AOUT Analog Output pin. Provides the converted Analog signal which is referenced to Vssa
(P0.26) i.e. the Analog GND. Set Bits[21:20] in PINSELL register to [10] to enable this
function.
These are reference voltage input pins used for both ADC and DAC. Vrerp is positive
Veere, reference voltage and Vrern is negative reference voltage pin. In example shown
Vi below we will use Vrern=0V(GND).
Vbpa is Analog Power pin and Vssa is Ground pin used to power the ADC module.
zDDA’ These are generally same as Vcc and GND but with additional filtering to reduce
SSA

noise.

DAC Registers in ARM Cortex-M3 LPC176x

The DAC module in ARM LPC1768/LPC1769 has 3 registers viz. DACR, DACCTRL,
DACCNTVAL. In this tutorial we will only go through to DACR register since the other two are
related with DMA operation, explaining which is not in the scope of this tutorial. Just note that
DMA is used to update new values to DACR from memory without the intervention of CPU.
This is particularly useful when generation different types of waveforms using DAC. We will
cover this in another tutorial.

Also note that the DAC doesn’t have a power control it in PCONP register. Simply select the
AOUT alternate function for pin P0.26 using PINSEL1 register to enable DAC ouput.

The DACR register in LPC1768
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The field containing bits [15:6] is used to feed a digital value which needs to be converted and
bit 16 is used to select settling time. The bit significance is as shown below:

1. Bit[5:0]: Reserved.

2. Bit[15:6] — VALUE: After a new VALUE is written to this field, given settling time
selected using BIAS has elapsed, we get the converted Analog voltage at the output. The
formula for analog voltage at AOUT pin is as shown above.

3. Bit[16] — BIAS: Setting this bit to 0 selects settling time of 1us max with max current
consumption of 700uA at max 1Mhz update rate. Setting it to 1 will select settling time of
2.5us but with reduce max current consumption of 300uA at max 400Khz update rate.

4. Bits[31:17]: Reserved

#

o [33A
EUREFP {_Similarcunnectinns will be present
Vgsp/0V

*VIREFN on most development boards

...............

P0.26 (Agyr)—©

[OR]
LPC1/6x | Vi [DSO] WCB]
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Triangle wave generation:-

#include "LPC17xx.h"
uint32_t val,
int main()
{
Systemlnit();
LPC_PINCON->PINSEL1 |= 0x02<<20; //p0.26 pinsel bits 20 and 21
while(1)
{
while(1)
{
val++;// increment values by 6
LPC_DAC->DACR=(val<<6);//send values to dac
if(val>=0x3ff)// if value exceeds 1024
{
break;
}
}
while(1)
{
val--; // decrement value by 6
LPC_DAC->DACR=(val<<6);// send value to dac
if(val<=0x000)// if value come down by 0

{
break;
}
}
}
}
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Square Wave generation:-

#include "LPC17xx.h"

void delay(unsigned int ms)// delay subroutine

{

unsigned int i,j;

for(i=0;i<ms;i++)
for(j=0;j<2000;j++);
}

int main()

{
Systemlnit();

LPC_PINCON->PINSEL1 |= 0x02<<20;//p0.26 pinsel bits 20 and 21
while(1)
{
LPC_DAC->DACR=0xffff;// send maximum values to dac
delay(20); // delay

LPC_DAC->DACR=0x0000;// send min values to dac

delay(20);
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Experiment No 6:-Interface 4X4 Matrix Keypad and display in LCD

Introduction 4x4 matrix keypad interface:-

There are various methods to provide an input for the GP10 pins of a microcontroller which can
be software controlled or hardware controlled. We have seen a hardware controlled method by
taking an input from a switch or a press button. Push Button Interfacing with LPC1768
The keypad is another external input device which is hardware controlled, but is used for a
specific purpose.
In this tutorial we take a look at how a 4x4 matrix keypad is interfaced with the LPC1768
microcontroller. The input taken from the matrix keypad will be displayed on a 16x2 lcd display
Basic Configuration
NOTE: Please read this section carefully as it is important to understand the hardware
connection before writing a software for this application.

e Aswe are using a 4x4 matrix keypad, a total of 8 input-output pins of the micro-

controller will be required for interfacing.
e One half of the 8 pins will be hardware controlled and the other half will be software

controlled.

P1.0 =1
1.1 - =
| = ==
1. — 3

=S WS ST ISWWa S WD

S 1O IS 1 IS 12 ISW1 3

— — e — e — e

s = - T > - T = - O_TM B2

ST I ) ISWW15 ISW 16 ST

S 1.8 ISV 19 ISWW 20 Iswww21

L= =>— L= > =] > P1.15 ==

T T
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/I Matrix Keypad Scanning Routine
1

// COL1 COL2 COL3 COL4
/101 2 3 ROW1

4 5 6 7 ROW?2

/18 9 A B ROWS3

//IC D E F ROWA4
TN
Main code:-
#include "lpcl7xx.h"
#include "lcd.h"
#define COL1
#define COL2
#define COL3
#define COL4
#define ROW1 9

#define ROW?2 10

#define ROW3 14

#define ROWA4 15

#define COLMASK ((1<<COL1) |(1<< COL2) |(1<< COL3) |(1<< COL4))
#define ROWMASK ((1<<ROW1) |[(1<< ROW?2) |(1<< ROWS3) |(1<<
ROW4))

#define KEY_CTRL_DIR LPC_GPIO1->FIODIR

#define KEY_CTRL_SET  LPC_GPIO1->FIOSET

#define KEY_CTRL_CLR  LPC_GPIO1->FIOCLR

#define KEY_CTRL_PIN  LPC_GPIO1->FIOPIN

o ~ B O

TN COLUMN WRITE /TN

void col_write( unsigned char data )

{

unsigned int temp=0;
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temp=(data) & COLMASK;
KEY_CTRL_CLR |= COLMASK;
KEY_CTRL_SET |= temp;
}
S e N
int main (void)
{
unsigned char key, i;
unsigned char rval[] = {0x77,0x07,0x0d};
unsigned char keyPadMatrix[] =
{
'4''8''B','F,
‘3,7 'A'VE',
2''6''0','D’,
'1''5''9','C'
3
Systeminit();
init_lcd();
KEY_CTRL_DIR |= COLMASK; //Set COLs as Outputs
KEY_CTRL_DIR &=~(ROWMASK); // Set ROW lines as Inputs
Icd_putstring16(0,"Press HEX Keys..");// 1% line display
lcd_putstring16(1,"Key Pressed = ");// 2" line display
while (1)
{
key = 0;
for(i=0;i<4;i++)
{
// turn on COL output one by one
col_write(rval[i]);
// read rows - break when key press detected
if {(KEY_CTRL_PIN & (1<<ROW1)))
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break;
key++;
if ({(KEY_CTRL_PIN & (1<<ROW?2)))
break;
key++;
if ({(KEY_CTRL_PIN & (1<<ROWS3)))
break;
key++;
if ({(KEY_CTRL_PIN & (1<<ROWS4)))
break;
key++;
}
if (key == 0x10)
lcd_putstring16(1,"Key Pressed = *);
else
{
lcd_gotoxy(1,14);
Icd_putchar(keyPadMatrix[key]);
}
}
}
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Experiment No 7:-Generate PWM waveform and vary its duty cycle

LPC1768 PWM Module
LPC1768 has 6 PWM output pins which can be used as 6-Single edged or 3-Double edged.
There as seven match registers to support these 6 PWM output signals. Below block diagram

shows the PWM pins and the associated Match(Duty Cycle) registers.

PWM Port ) Associated Corresponding
. Pin Functions ] ]

Channel  Pin PINSEL Register Match Register
0-GPIO, 1-PWM1[1], 2-TXD1, 0,1 bits of

PWM 1 P2.0 MR1
3- PINSEL4
0-GPIO, 1-PWM1[2], 2-RXD1, 2,3 bits of

PWM 2 P2.1 MR2

B 3- PINSEL4

0-GPIO, 1-PWM1[3], 2-CTS1, 4,5 bits of

PWM 3 P22 MR3
3-TRACEDATA]3] PINSEL4
0-GPI0O, 1-PWML1[4], 2-DCD1, 6,7 bits of

PWM_ 4 P23 MR4
3-TRACEDATA[2] PINSEL4
0-GPIO, 1-PWML1][5], 2-DSR1, 8,9 bits of

PWM 5 P24 MR5
3-TRACEDATA[1] PINSEL4
0-GPIO, 1-PWML1]6], 2-DTR1, 10,11 bits of

PWM_ 6 P25 MR6
3-TRACEDATA[O] PINSEL4

LPC1768 PWM Registers
The below table shows the registers associated with LPC1768 PWM.

Register Description

Interrupt Register: The IR can be read to identify which of eight possible interrupt

R sources are pending. Writing Logic-1 will clear the corresponding interrupt.

TCR Timer Control Register: The TCR is used to control the Timer Counter
functions(enable/disable/reset).

TC Timer Counter: The 32-bit TC is incremented every PR+1 cycles of PCLK. The TC is
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PR

PC

MCR

MRO

MR1-
MR6

PCR

LER

controlled through the TCR.
Prescalar Register: This is used to specify the Prescalar value for incrementing the TC.

Prescale Counter: The 32-bit PC is a counter which is incremented to the value stored
in PR. When the value in PR is reached, the TC is incremented.

Match Control Register: The MCR is used to control the reseting of TC and generating
of interrupt whenever a Match occurs.

Match Register: This register hold the max cycle Time(Ton+Toff).

Match Registers: These registers holds the Match value(PWM Duty) for
corresponding PWM channels(PWM1-PWM6).

PWM Control Register: PWM Control Register. Enables PWM outputs and selects

PWM channel types as either single edge or double edge controlled.

Load Enable Register: Enables use of new PWM values once the match occurs.

Steps to Configure PWM

1.
2.

I

Configure the GPIO pins for PWM operation in respective PINSEL register.

Configure TCR to enable the Counter for incrementing the TC, and Enable the PWM
block.

Set the required pre-scalar value in PR. In our case it will be zero.

Configure MCR to reset the TC whenever it matches MRO.

Update the Cycle time in MRO. In our case it will be 100.

Load the Duty cycles for required PWMx channels in respective match registers MRx(X:
1-6).

Enable the bits in LER register to load and latch the new match values.

Enable the required pwm channels in PCR register.

Main code:-

#include <lpcl7xx.h>

void delay _ms(unsigned int ms)
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unsigned int i,j;
for(i=0;i<ms;i++)
for(j=0;j<60000;j++);

#define SBIT_CNTEN 0
#define SBIT_PWMEN 2

#define SBIT_PWMMROR 1

#define SBIT_PWMENAL1 9

#define PWM_1 0//P2_0 (0-1 Bits of PINSEL4)

int main(void)
{
int dutyCycle;
Systemlnit();
/* Cofigure pins(P2_0) for PWM mode. */
LPC_PINCON->PINSEL4 = (1<<PWM_1) ;

/* Enable Counters,PWM module */
LPC PWM1->TCR = (1<<SBIT_CNTEN) | (1<<SBIT_PWMEN);

LPC_PWM1->PR = 0x00; /* No Prescalar */
LPC_PWM1->MCR = (1<<SBIT_PWMMROR); /*Reset on PWMMRO, reset TC if it

matches MRO */

LPC_PWM1->MRO = 100; I* set PWM cycle(Ton+Toff)=100) */
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/* Enable the PWM output pins for PWM_1-PWM_4(P2_0 - P2_3) */
LPC_PWM1->PCR = (1<<SBIT_PWMENAL1);

while(1)

{
for(dutyCycle=0; dutyCycle<100; dutyCycle++)

{
LPC_PWM1->MR1 = dutyCycle; /* Increase the dutyCycle from 0-100 */
delay_ms(5);

for(dutyCycle=100; dutyCycle>0; dutyCycle--)

{

LPC_PWM1->MR1 = dutyCycle; /* Decrease the dutyCycle from 100-0 */

delay_ms(5);
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Experiment No 8:-Using external interrupt switches toggle the led’s

EINTX Pins
LPC1768 has four external interrupts EINTO-EINTS3.
As LPC1768 pins are multi functional, these four interrupts are available on multiple pins.

Below table shows mapping of EINTX pins.

Port Pin PINSEL_FUNC_0 PINSEL_FUNC_1 PINSEL_FUNC_2 PINSEL_FUNC_3

P2.10 GPIO EINTO NMI

P2.11  GPIO EINT1 12STX_CLK
P2_12 GPIO EINT2 12STX_WS
P2.13 GPIO EINT3 I2STX_SDA

LPC1768 External Interrupts

Normal
Application

LPC1768

Normal
Application

EINT Registers

Below table shows the registers associated with LPC1768 external interrupts.
Register Description
PINSELXx  To configure the pins as External Interrupts

External Interrupt Flag Register contains interrupt flags for EINTO,EINTL1, EINT2
& EINT3.

EXTINT

EXTMODE External Interrupt Mode register(Level/Edge Triggered)
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EXTPOLAR External Interrupt Polarity(Falling/Rising Edge, Active Low/High)

EXTINT

31:4 3 2 1 0

RESERVED EINT3 EINT2 EINT1 EINTO

EINTx: Bits will be set whenever the interrupt is detected on the particular interrupt pin.
If the interrupts are enabled then the control goes to ISR.

Writing one to specific bit will clear the corresponding interrupt.

EXTMODE

31:4 3 2 1 0

RESERVED EXTMODE3 EXTMODE2 EXTMODE1 EXTMODEOQ

EXTMODEX: This bits is used to select whether the EINTX pin is level or edge Triggered
0: EINTX is Level Triggered.
1: EINTX is Edge Triggered.

EXTPOLA
R

31:4 3 2 1 0
RESERVED EXTPOLARS3 EXTPOLAR2 EXTPOLAR1 EXTPOLARO

EXTPOLARX: This bits is used to select polarity(LOW/HIGH, FALLING/RISING) of the
EINTX interrupt depending on the EXTMODE register.

0: EINTX is Active Low or Falling Edge (depending on EXTMODEX).

1: EINTx is Active High or Rising Edge (depending on EXTMODEX).

Steps to Configure Interrupts
1. Configure the pins as external interrupts in PINSELX register.

2. Clear any pending interrupts in EXTINT.
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3. Configure the EINTX as Edge/Level triggered in EXTMODE register.

4. Select the polarity(Falling/Rising Edge, Active Low/High) of the interrupt in
EXTPOLAR register.

5. Finally enable the interrupts by calling NVIC_EnableIRQ() with IRQ number.

-2 _3W

Rss rRs9
1O 10K

E=EIrdT 3 =EIiINNT =
II SsSvwwa22> sSwWwa23

Main code:-

#include <lpcl7xx.h>

#define PINSEL_EINT1 22 // interrupt 1
#define PINSEL_EINT2 24 // interrupt 2

#define LED1 25 // led at p1.25
#define LED2 26 /I led at p1.26

#define SBIT_EINT1 1 //extint bit 1
#define SBIT_EINT2 2 //extint bit 2

#define SBIT_EXTMODE1 1 /lextint mode bit 1
#define SBIT_EXTMODE2 2 /lextint mode bit 2

#define SBIT_EXTPOLAR1 1 //extint polarity mode bit 1
#define SBIT_EXTPOLAR2 2 //extint polarity mode bit 2
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void EINT1_IRQHandler(void)

{

LPC_SC->EXTINT = (1<<SBIT_EINTL); /* Clear Interrupt Flag */

LPC_GPIO1->FIOPIN "= (1<< LED1); /* Toggle the LED1 everytime INTR1 is generated
*/
¥

void EINT2_IRQHandler(void)

{
LPC_SC->EXTINT = (1<<SBIT_EINT2); /* Clear Interrupt Flag */
LPC_GPIO1->FIOPIN "= (1<< LED2); /* Toggle the LED2 everytime INTR2 is generated
*/
¥
int main()
{

Systemlnit();

LPC SC->EXTINT =(1<<SBIT_EINT1) |(1<<SBIT_EINT2); * Clear Pending
interrupts */

LPC_PINCON->PINSEL4 = (1<<PINSEL_EINT1) | (1<<PINSEL_EINTZ2); /* Configure
P2_11,P2 12 as EINT1/2 */

LPC_SC->EXTMODE = (1<<SBIT_EXTMODE1) | (1<<SBIT_EXTMODEZ2); /*
Configure EINTx as Edge Triggered™*/

LPC_SC->EXTPOLAR = (1<<SBIT_EXTPOLAR1)| (1<<SBIT_EXTPOLAR2); /*
Configure EINTx as Falling Edge */
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LPC_GPIO1->FIODIR = (1<<LED1) |(1<<LED?2); /* Configure LED pins as

OUTPUT */
LPC_GPIO1->FIOPIN = 0x00;

NVIC_EnableIRQ(EINT1_IRQn);
NVIC_EnableIRQ(EINT2_IRQn);

while(1)

{
/I Do nothing

¥

/* Enable the EINT1,EINT2 interrupts */
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Experiment No 9:-Display 0-F in 7 segment display

The displays common pin is generally used to identify which type of 7-segment display it is. As
each LED has two connecting pins, one called the “Anode” and the other called the “Cathode”,
there are therefore two types of LED 7-segment display called: Common Cathode (CC) and
Common Anode (CA).

The difference between the two displays, as their name suggests, is that the common cathode has
all the cathodes of the 7-segments connected directly together and the common anode has all the
anodes of the 7-segments connected together and is illuminated as follows.

1. The Common Cathode (CC) — In the common cathode display, all the cathode connections of
the LED segments are joined together to logic “0” or ground. The individual segments are
illuminated by application of a “HIGH”, or logic “1” signal via a current limiting resistor to
forward bias the individual Anode terminals (a-g).

Common Cathode 7-segment Display

a e qui A e a
bo—}l‘;- bee— 5 s
c e H: C ] fI Ib
de H:+ d—: i
e e H," T e ’.:
feo H,‘ f— 2.4 Jop
g ol g —= °
_"_‘H"‘ Comm on v-
Cathods —

2. The Common Anode (CA) — In the common anode display, all the anode connections of the
LED segments are joined together to logic “1”. The individual segments are illuminated by
applying a ground, logic “0” or “LOW” signal via a suitable current limiting resistor to the
Cathode of the particular segment (a-g).

Common Anode 7-segment Display
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Comm ot +
-H‘;/,,/ Anode —= h
a Q‘*H 1 A a
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In general, common anode displays are more popular as many logic circuits can sink more
current than they can source. Also note that a common cathode display is not a direct
replacement in a circuit for a common anode display and vice versa, as it is the same as
connecting the LEDs in reverse, and hence light emission will not take place.

Depending upon the decimal digit to be displayed, the particular set of LEDs is forward biased.
For instance, to display the numerical digit 0, we will need to light up six of the LED segments
corresponding to a, b, ¢, d, e and f. Thus the various digits from 0 through 9 can be displayed

using a 7-segment display as shown.

7-Segment Display Segments for all Numbers.

2 2 4 a a a
I | | L] | I L]

z 2
—
g | I I Y d 5 I B
= = = = = =

[ L [ [ [ [
I [ | [ |

Then for a 7-segment display, we can produce a truth table giving the individual segments that
need to be illuminated in order to produce the required decimal digit from O through 9 as shown

below.

7-segment Display Truth Table

Decimal Individual Segments Illuminated
Digit 'a b ¢ d e f g

0 X X X X X X
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1 X X

2 X X X X X
3 X X X X X
4 X X X X
5 X X X X X
6 X X X X X X
7 X X X

8 X X X X X X X
9 X X X X X

Driving a 7-segment Display

Although a 7-segment display can be thought of as a single display, it is still seven individual
LEDs within a single package and as such these LEDs need protection from over current. LEDs
produce light only when it is forward biased with the amount of light emitted being proportional
to the forward current.

This means then that an LEDs light intensity increases in an approximately linear manner with
an increasing current. So this forward current must be controlled and limited to a safe value by
an external resistor to prevent damage to the LED segments.

The forward voltage drop across a red LED segment is very low at about 2-to-2.2 volts, (blue
and white LEDs can be as high as 3.6 volts) so to illuminate correctly, the LED segments should
be connected to a voltage source in excess of this forward voltage value with a series resistance
used to limit the forward current to a desirable value.

Typically for a standard red coloured 7-segment display, each LED segment can draw about 15
mA to illuminated correctly, so on a 5 volt digital logic circuit, the value of the current limiting
resistor would be about 200Q (5v — 2v)/15mA, or 220% to the nearest higher preferred value.
So to understand how the segments of the display are connected to a 220Q current limiting

resistor consider the circuit below.
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100E R22
]];}'[1' 100E R23
Pl4 100E R24
PL8 100E R265
PLO 100E R27
PL.10 100E R29
PL.14 100E R31
SEVEN SEGMENT T T
INTERFACE TowLwoom= IToLwoom<
COM1 — COM1
BLOCK COM2 «— Ccom?2
- AT9542 AT9542
DIS1 DIS2
P08 R3& 5 Q4
1K M BCB547
[ar!
P4.28 R40 5 Q6
’\ﬂ BC547
1K
o
®® —_  |+5v

JP1

For illuminate a digit we have to

make a appropriate port Low

@ (send 0).Here 1%t make P0.8 or

P4.28 High. It will send control

™)
@)

active signal to segment. Then

\f@ initially make

N 7N P1.0,P1.1,P1.4,P1.8,P1.9,P1.10,
E C P1.14 all high. Now all the

V@f digits become off. Then make

respected segment low by

sending CLR signal to GPIO.

This cause the segment to illuminate.
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Main Code:-
#include <lpcl7xx.h>

void delay_ms(unsigned int ms)

{

unsigned int i,j;

for(i=0;i<ms;i++)
for(j=0;j<40000;j++);

[* start the main program */
int main()

{
Systemlnit(); /[Clock and PLL configuration

LPC_GPIO0->FIODIR = 0x00000100; //Configure the PORTO pins as OUTPUT;
LPC_GPIO1->FIODIR = 0x00004713;// all segment as output

while(1)
{

LPC_GPIO0->FIOSET = 0x00000100; // Make all the Port pins as high

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments

LPC_GPIO1->FIOSET = 0x00004000;// set g to make 0

delay_ms(200);
LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
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LPC_GPIO1->FIOSET = 0x00004701;//set a,d,e,f,g to make 1
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000410;//set c,f to make 2
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000600;//set e and f to make 3
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000301;//set a,d,e to make 4
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000202;//set b,e to make 5
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000002;//set b to make 6
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00004700;//set d,e,f,g to make 7
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000000;//set all 0 to make 8
delay _ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000300;//set e to make 9
delay _ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000100;//set d to make A
delay _ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000003;//set a,b to make b
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delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00004012;//set set b,c,g to make C
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000401;//set a,f to make d
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000012;//set b,c to make E
delay_ms(200);

LPC_GPIO1->FIOCLR = 0x00004713;//clear all segments
LPC_GPIO1->FIOSET = 0x00000112;//set b,c,d to make F
delay_ms(200);
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Experiment No 10:-Interface a switch and display status in LED, Relay and

Buzzer

switch

P21l )f——  ——— O

L. PC1768

P1-27

rP1.19 Led
. >

Here switch is pulled up to +3.3 volt. So when pressed port should read active low

signal(0),normal condition is active high(1)

Main code:-

#include <lpcl7xx.h>

#define SwitchPinNumber 11// port P2.11 connected to switch
#define LedPinNumber 19 //port 1.19-p1.26 connected to 8 leds
#define relayPinNumber 28 //port P1.28 connected to relay

#define buzzerPinNumber 27 //port P1.27 connected to buzzer

int main (void)

{

uint32_t switchStatus;

LPC_GPIO1->FIODIR = 0x1ff80000; I* P1.xx defined as Outputs */
LPC_GPIO1->FIOCLR = 0x1ff80000; /* turn off all the LEDs&relay&buzzer */
LPC_GPI102->FIODIR = 0x00000000; I* P2.xx defined as input */
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while(1)
{

/* Turn On all the leds and wait for one second */
switchStatus = (LPC_GP102->FIOPIN>>SwitchPinNumber) & 0x01 ; // Read the switch

status

if(switchStatus == 0) /1if switch pressed

{
LPC_GPIO1->FIOPIN =

(1<<buzzerPinNumber)|(1<<relayPinNumber)|(1<<LedPinNumber);//turn on led,relay and

buzzer
}
else /1if switch released
{
LPC_GPIO1->FIOPIN =
(O<<buzzerPinNumber)|(O<<relayPinNumber)|(0<<LedPinNumber); /1if switch released

led,relay,buzzer off

¥
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Experiment No 11:-Interface SPI ADC and display Ambient temperature
Pin Assignment with LPC1768

P0.28
190l
CLK P0.27
1
Dout P3.26 e
= 1l CasHON VddVia
SoK
Lo oH—=
0ouT
5 Lo puE——
O
MCP 4 Vs [,in_ﬁ_
3202 | MCER00
. 4 ADC/LM35 Interface
VR
Din P3.25 10K
=
gl
I
IV
oNI
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Main code:-
#include <LPC17xx.H>
#include <stdint.h>
#include <stdio.h>
#include "delay.h"
#include "spi_manul.h"
#include "lcd.h"
#define pulse_val 2
main()
{
unsigned int spi_rsv=0;
float vin;
char buf{20];
Systemlnit ();
Icd_init();
Icd_str("SPI 3202-b");
delay(60000);
delay(60000);
while(1)
{
Icd_clr();
Icd_cmd(0x80);
spi_rsv = spi_datal(15);
vin = ( (spi_rsv & Oxfff) * (3.3) ) / 4096 ;

sprintf(buf,"Temp: %0.2f degC",(vin*100) );

Icd_str(buf);
delay(50000);
delay(50000);

¥

}
SPI ADC data fetching program:-
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#include <LPC17xx.H>

#include "delay.h"

#define pulse_val 2

#define CLK 1<<27

#defineCS 1<<28

#define DDOUT 26

#defineDOUT 1<<25

#defineDIN 1<<26

#define spi_stst 0

unsigned int spi_data(char sel)

{
char clks = 4;
LPC_GPI100->FIODIR |= CS|CLK;
LPC_GPIO3->FIODIR = DOUT;

LPC_GPIO0->FIOSET = CS|CLK;
LPC_GPIO3->FIOCLR = DOUT;
nop_delay(100);
#if spi_stst
if (LPC_GPIO3->FIOPIN & DIN )
{
return ‘P’
}
#endif
LPC_GPIO0->FIOCLR =CS;
nop_delay(pulse_val);
while(clks)
{
LPC_GPIO0->FIOCLR = CLK;

nop_delay(pulse_val);
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LPC_GPIO3->FIOPIN = (sel & 1) << DDOUT;

sel =sel >>1;

LPC_GPIO0->FIOSET = CLK;,

nop_delay(pulse_val);

clks--;
}
LPC_GPIOO0->FIOCLR = CLK;
nop_delay(pulse_val);
if (I( LPC_GP103->FIOPIN & DIN ) )
{

return 'U";

clks = 12;
while(clks)
{
clks--;
LPC_GPIO0->FIOCLR = CLK;
nop_delay(pulse_val);
LPC_GPIO0->FIOSET = CLK;

nop_delay(pulse_val);

nop_delay(pulse_val);
if (!( LPC_GPIO3->FIOPIN & DIN))

{

return 'U";

¥

return 'Z";

¥

unsigned int spi_datal(char sel)
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{

unsigned int spi_reg=0;
char clks = 12;
LPC_GPI100->FIODIR |= CS|CLK;
LPC_GPIO3->FIODIR = DOUT;

LPC_GPIO0->FIOSET = CS|CLK;
LPC_GPIO3->FIOSET = DOUT,;
LPC_GPI03->FIOPIN = DIN;

nop_delay(100);

LPC_GPIO0->FIOCLR =CS;
[Istart condi

LPC_GPIO0->FIOCLR = CLK,;
LPC_GPIO3->FIOSET = DOUT;
nop_delay(pulse_val);
LPC_GPIO0->FIOSET = CLK;
nop_delay(5);

/Isingle mode
LPC_GPIO0->FIOCLR = CLK,;
LPC_GPIO3->FIOSET = DOUT;

nop_delay(pulse_val);
LPC_GPIO0->FIOSET = CLK;
nop_delay(5);

/Ichanl 1
LPC_GPIO0->FIOCLR = CLK,;
LPC_GPIO3->FIOSET = DOUT;

DEPT OF ECE, HMSIT, TUMKUR



Arm Microcontroller Lab Manual

nop_delay(pulse_val);
LPC_GPIOO->FIOSET = CLK,;
nop_delay(5);

//msb first
LPC_GPIOO0->FIOCLR = CLK,;
LPC_GPIO3->FIOSET = DOUT;

nop_delay(pulse_val);
LPC_GPIOO->FIOSET = CLK,;
nop_delay(5);
//smpling
// LPC_GPIO0->FIOCLR = CLK;
/I nop_delay(pulse_val);
/I LPC_GPIO0->FIOSET = CLK;
/I nop_delay(2);

/Inull bit
LPC_GPIO0->FIOCLR = CLK,;
nop_delay(pulse_val);
LPC_GPIO0->FIOSET = CLK;
/I while ( ( LPC_GPIO3->FIOPIN & DIN ) == DIN);
I/ if(}( LPC_GPIO3->FIOPIN & DIN) );
I {
Il return'U;
I}
nop_delay(5);
clks = 12;
while(clks)

{
LPC_GPIO0->FIOCLR = CLK;
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nop_delay(pulse_val);
LPC_GPIOO->FIOSET = CLK;
if( ( LPC_GPIO3->FIOPIN & DIN))
{

spi_reg |= 1<<(clks-1);
}
else
{

Spi_reg = spi_reg;
}
clks--;
nop_delay(5);
}

nop_delay(1);

return spi_reg;

¥

LCD display program:-

#include <LPC17xx.H>
#include "delay.h"
#define RRW (7<<9)
#define DATA_L (15<<19)
void lcd_pin(void)
{
LPC_GPIO0->FIODIR |= RRW|DATA L;

}

void lcd_cmd(unsigned char cmd)

{
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LPC_GPIOO0->FIOPIN =( ( (cmd & 0xf0 )>> 4) << 19)| (1<<11);
delay(200);
LPC_GPIOO0->FIOPIN =( ( (cmd & 0xf0 )>> 4) << 19);

LPC_GPIO0->FIOCLR |= RRW|DATA L;
delay(10);

LPC_GPIOO0->FIOPIN = ( ( (cmd & 0xf) ) << 19)] (1<<11);

delay(200);
LPC_GPIOO0->FIOPIN = (( (cmd & 0xf) ) << 19);

void lcd_data(unsigned char cmd)

{
LPC_GPIO0->FIOPIN =(1<<9)|( ( (cmd & 0xf0 )>> 4) << 19)| (1<<11);
delay(200);
LPC_GPIO0->FIOPIN =( ( (cmd & 0xf0 )>> 4) << 19);
LPC_GPIO0->FIOCLR |= RRW|DATA L;
delay(10);
LPC_GPIO0->FIOPIN = (1<<9)|( ( (cmd & 0xf) ) << 19)] (1<<11);
delay(200);
LPC_GPIO0->FIOPIN = (((cmd & Oxf) ) << 19);
}
void lcd_init(void)
{
Icd_pin();
lcd_cmd(0x03);
delay(3000);
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Icd_cmd(0x03);
delay(1000);
Icd_cmd(0x03);
delay(100);
Icd_cmd(0x2);
Icd_cmd(0x28);
Icd_cmd(0x0e);
Icd_cmd(0x06);
Icd_cmd(0x01);
delay(1);

void lcd_str(char *Istr)
{
while(*Istr)
{
Icd_data(*Istr);

Istr++;

}

}

void lcd_clr(void)

{

lcd_cmd(0x03);

delay(10);
lcd_cmd(0x2);
lcd_cmd(0x28);
lcd_cmd(0x0e);
lcd_cmd(0x06);
lcd_cmd(0x01);
delay(10);
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PN PRE

o

10.

11.

12.

13.

14.

15.

16.

17.

4. Viva Question

These are few very simple and general ARM processor interview questions

What are the types of CORTEX-M series ?

How do you select a specific CORTEX-M processor ?

What is Microprocessor?

Microprocessor is a CPU fabricated on a single chip program controlled device, which
fetched the instructions from memory, decodes and execute the instructions. Three basic
characteristic differentiate microprocessor.

Instruction Set: The set of instruction microprocessor can execute.

Bandwidth: The number of bit’s processed in a single instruction

Clock Speed: Given in MHz Megahertz, the clock speed determines how many instructions
per second the processor can execute.

In addition to this, microprocessors are classified as being RISC (Reduced Instruction Set
Computer) or CISC (Complex Instruction Set Computer).

What are the basic units of Microprocessor?

The basic units or block of microprocessor are ALU, an Array of Registers and control unit.
Give Examples for8/16/32-bit Microprocessor?

8-bit Processors- 8085, Z80, 6800

16-bit Processors- 8086, 68000, Z8000

32-bit Processors- 80386, 80486

64-bit Processors- Intel 64(x64), AMD64, IBM (Power PC), SUN (SPARC).

What are 1%t/ 2"/394th generation processors?

The processors made of PMOS, NMOS, HMOS, HCMOS technology are called 1%/
2nd/31/4th ganeration processor’s and are made up of 4, 8, 16, 32-bits.

What does microprocessor speed depends on?

The speed of microprocessor depends on various factors such as Data Bus Width (Number
of instruction it processes) and clock speed.

What is Software and Hardware?

The software is set of instruction or commands needed for performing a specific task by
programmable device or a computing machine. The hardware refers to the component or
device used to form computing machine in which software can be run and tested. Without
software hardware is idle machine.

Distinguish between microprocessor and microcontroller?

The microprocessor is a digital integrated circuit that can be programmed with a series of
instructions to perform a specified function on data. The microcontroller is tiny little
computer on single integrated circuit, which has memory, input-output on chip itself. So
we can say microprocessor can perform few functions but microcontroller can perform
many functions.

What are disadvantages of Microprocessor?

Microprocessor has limitation on size of data. Most microprocessor does not support
floating point operation.

What is the difference between microprocessor and microcontroller?

op-codes and more bit handling instructions also microcontroller defined as a device that
includes microprocessor, memory and input-output signal lines in a single chip.

What is an Instruction?

An instruction is an order given to a computer processor by a computer program. At the
lowest level each instruction set is a sequence of Os and 1s that describes a physical
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operation that computer is to perform (such as “Add”) and depending on the particular
instruction type, the specification of special storage areas called registers that may
contain data be used in carrying out the instruction or the location in computer memory
of data.
18. What is clock cycle?
The speed of computer processor is determined by clock cycle, which is amount of time
between two pulses of an oscillator. In general, the higher number of pulses per second
the faster the computer processor will be able to process information.
19. ARM stands for Advanced RISC Machines
a) Advanced Rate Machines
b) Advanced RISC Machines
c) Artificial Running Machines
d) Aviary Running Machines
View Answer
Answer: b
Explanation: ARM is a type of system architecture.
20. The main importance of ARM micro-processors is providing operation with
a) Low cost and low power consumption
b) Higher degree of multi-tasking
c) Lower error or glitches
d) Efficient memory management
View Answer
Answer: a
Explanation: The Stand alone feature of the ARM processors is that they’re economically
viable.
21. ARM processors where basically designed for
a) Main frame systems
b) Distributed systems
c) Mobile systems
d) Super computers
View Answer
Answer: c
Explanation: These ARM processors are designed for handheld devices.
22. The ARM processors doesn’t support Byte address ability ?
a) True
b) False
View Answer
Answer: b
Explanation: The ability to store data in the form of consecutive bytes.
23. The address space in ARM is
a) 224
b) 264
C) 216
d) 232
View Answer
Answer:d
Explanation: None.
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24. The address system supported by ARM systems is/are
a) Little Endian
b) Big Endian
c) X-Little Endian
d) Both Little & Big Endian
View Answer
Answer: d
Explanation: The way in which, the data gets stored in the system or the way of address
allocation is called as address system.
25. Memory can be accessed in ARM systems by instructions.
i) Store
ii) MOVE
iii) Load
iv) arithmetic
v) logical
a) i, ii, jii
b) i,ii
c)i,iv,v
d) iii,iv,v
View Answer
Answer: b
Explanation: None.
26. RISC stands for
a) Restricted Instruction Sequencing Computer
b) Restricted Instruction Sequential Compiler
c) Reduced Instruction Set Computer
d) Reduced Induction Set Computer
View Answer
Answer: ¢
Explanation: This is a system architecture, in which the performance of the system is
improved by reducing the size of the instruction set.
27. In ARM, PCis implemented using
a) Caches
b) Heaps
c) General purpose register
d) Stack
View Answer
Answer: ¢
Explanation: PCis the place where the next instruction about to be executed is stored.
28. The additional duplicate register used in ARM machines are called as
a) Copied-registers
b) Banked registers
c) EXtra registers
d) Extential registers
View Answer
Answer: b
Explanation: The duplicate registers are used in situations of context switching.
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29.

30.

31.

32.

33.

The banked registers are used for

a) Switching between supervisor and interrupt mode

b) Extended storing

c) Same as other general purpose registers

d) None of the mentioned

View Answer

Answer: a

Explanation: When switching from one mode to another, instead of storing the register
contents somewhere else it’ll be kept in the duplicate registers and the new values are
stored in the actual registers.

Each instruction in ARM machines is encoded into ____ Word.

a) 2 byte

b) 3 byte

c) 4 byte

d) 8 byte

View Answer

Answer: c

Explanation: The data is encrypted to make them secure.

All instructions in ARM are conditionally executed.

a) True

b) False

View Answer

Answer: a

Explanation: None.

The addressing mode where the EA of the operand is the contents of Rn is
a) Pre-indexed mode

b) Pre-indexed with write back mode

c) Post-indexed mode

d) None of the mentioned

View Answer

The effective address of the instruction written in Post-indexed mode, MOVE[Rn]+Rm is

a) EA = [Rn].

b) EA = [Rn + Rm].

c) EA=[Rn] + Rm

d) EA=[Rm] +Rn

View Answer

Answer: a

Explanation: Effective address is the address that the computer acquires from the current
instruction being executed.
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